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How to use this guide

This guide tells you how to use P4Admin, a GUI for administrating Helix Server connections. It is
intended for anyone using P4Admin to perform basic Helix Server administrative tasks. Access to the
complete set of administrative tools requires P4, the c ommand-line client.

Feedback

How can we improve this manual? Email us at manual@perforce.com.

Other documentation

See https://www.perforce.com/support/self-service-resources/documentation.

Syntax conventions

Helix documentation uses the following syntax conventions to describe command line syntax.

Notation Meaning

Titeral Must be used in the command exactly as shown.

italics A parameter for which you must supply specific information. For example, for
a serverid parameter, supply the ID of the server.

[-f] The enclosed elements are optional. Omit the brackets when you compose
the command.

m Repeats as much as needed:

. alias-name[[$(argl)...
[$Cargn)]]=transformation

m Recursive for all directory levels:

. clone perforce:1666 //depot/main/p4...
~/1ocal-repos/main

« p4 repos -e //gra.../rep...

element1 | Either element1 or element2 is required.
element2

S
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Administering Helix Server using P4Admin

P4Admin provides a graphical user interface for performing basic Helix Server administration tasks. This
chapter discusses the following topics:

Home pPage .. ... .. o 5
Server conNNections ... .. ... 6
Managing depots .. ... ... . 6
Managing users and groups ......... ... ..., 6
Managing permissSions ... ... ... 8
VIEW PEIMISSIONS . e 8
Editthe protections table ... . 8
Configuring P4Admin preferences ... ... ... ... 9
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To access P4Admin from within P4V, go to Tools > Admininstration.

Home page

The Administration home page enables users with super and adm1i n permissions to view and use the
following:

m Server information: displays details about the server to which you are connected.

m Disk space usage: displays details about server disk space usage.

m Security level: displays authentication level required by users who access the server.
= Account management shortcuts: displays links to common tasks.

m User licenses: displays details about license count and expiration.

m Inactive users: displays details about users who have not accessed their account in the period of
time you specify.



Server connections

Server connections

To administer a server, you must first connect to it as a user that has been granted superuser privilege for
the server. (If your user does not have superuser privilege, you can still administer users and groups, but
cannot manage permissions or define depots.)

To connect to a server, choose Connections > Open Connection. Specify the desired settings and
click OK. To administer a server, activate the connection by clicking its entry in the Connections pane.
To remove a connection, right-click it and select Close Connection.

P4Admin retains all connections that you define, so you do not need to reenter them the next time you
launch the tool.

Managing depots

If you have super user permission for the Helix Server instance to which you are connected, you can
manage the depots that it contains. Specifically, you can:

m Display details about a depot
m Create, edit, or delete depots

m Obliterate files from a depot

Warning
Obliterate with extreme caution. Obliteration permanently removes all traces of the specified

files from the Helix Server, including revision records and metadata (such as references in
labels and client workspace specifications). Files in client workspaces are left untouched, but
are no longer recognized as being under Helix Server control.

Managing users and groups

All users can display lists of users and groups using P4Admin, but only users with admin or super
permissions can make changes. For details about access levels, refer to the Helix Versioning Engine
Administrator Guide: Fundamentals.

To view the users defined for the server to which you are connected, select Tools >
Administration and click the Users & Groups tab.

To display details about a user, click the desired user specification. The details about that user are
displayed at the bottom of the Users tab.

To create a user:

1. InP4V, select Tools > Administration. P4Admin opens.

2. Choose File > New > User.
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Managing users and groups

The User dialog opens.

3. Enter userinformation as follows. Click OK after making your entries.

User The Helix Server user name.

Password  The password (if any) required for the user to connect to the server.

Email The user's email address.

Full The user's real name.

name

Job view (Optional) Criteria specifying which jobs are automatically included on any new
changelists created by the user
Example: User=bruno Status=open
For details, refer to the description of the p4 jobs-e flag in the Perforce
Command Reference.

Reviews Files of interest to the user, specified using depot syntax
When changelists that affect the file are submitted, the user receives email
notification of the change. Note that you can also specify files of interest by
clicking the Reviews tab.

Groups Groups to which the user belongs

To add the user to a group, enter the name of the group in the Group field and
click Add, or click Browse, select the group, and click OK.

To change your password: Select Administration > Change Password.

To display the groups to which a user belongs, expand the user in the Users pane. To display the
users in a group, expand the group in the Groups pane.

To edit a user or group, right-click the user or group you want to edit and select Edit.

To see the areas of the depot tree to which a user has access, right-click the user, and select Show
Permissions. The Permissions tab is displayed, with the selected user highlighted.

To add a user to a group, drag the user from the Users pane to the desired group. To remove a user
from a group, right-click the user in the group and choose Remove.

To edit the groups to which a user belongs:

1. Right-click the user and select Edit User.

The User dialog is displayed.

2. Edit the list displayed in the Group membership field.
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Managing permissions

Managing permissions

For details about how permissions work within Helix Server, see the Helix Versioning Engine
Administrator Guide: Fundamentals.

View permissions

To display the files and folders to which a user has access, click the desired user on the Users tab.

To display the files and folders to which users in a group have access, click the desired group on
the Groups tab.

To display the groups and users that have access to a file or folder, click the file or folder on the
Depot Tree tab.

To see which lines of the protections table control access to a user, group, or area of the depot,
click the user, group or folder of interest. The corresponding line in the protections table is highlighted. (If
a user or group is neither granted nor denied access to a path by means of any entries in the protections
table, the depot path displays "no access" and the "granted to" field is blank.)

To filter out lines in the right-hand pane, use the Access Level sliders to set the lowest and highest
levels. The areas of the depot associated with the highlighted range of access values are displayed.

To see only those permissions that apply to a user’s workstation, enter the IP address of the
workstation in the Host IP filter field. For example, permissions lines with a host value of
92.168.*.%and192.168.1. * both apply to a workstationat 192.168.1.10.

To show files in the Depot Tree, click Show files.
Note

Virtual streams do not appear in the Depot Tree on the Permissions tab. Virtual streams map their
parent’s paths, and permissions for virtual streams are therefore always set for the parent’s paths.

Edit the protections table

The protections table is displayed in the bottom pane of the screen. It is a representation of the table used
by the p4 protect command, with exclusionary lines shown in red. For more information on the p4
protect command, see p4 protect inthe P4 Command Reference.

To edit the protections table, use the built-in editor or click E to edit the protections table as text.

To deny access to a specific portion of the depot to a user or group, use an exclusionary mapping: place a
dash (-) in front of the path in the Folder/File field. Exclusionary mappings apply to all access levels,
even though only one access level can be selected in the Access Level field.

The following table describes the fields in the protections table.
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Configuring P4Admin preferences

Access
Level

The permission being granted. Each permission level includes all lower-level
permissions, except for review.

m super: Grants access all commands and command options

= admin: Permits those administrative commands and command options that
don’t affect server security

m write: Lets users submit open files
m open: Lets users open files for add, edit, delete, and integrate
m read: Lets users sync, diff, and print files

m list: Lets users see names but not contents of files; users can see all non-file
related metadata (workspaces, users, changelists, jobs, etc.

= review: Allows access to the p4 review command. This leve is intended
for automated processes. It implies read access.

= ##: Adds a comment line to the protections table. For example:

## robinson crusoe
write user * 10.1.1.1  //depot/test/...

User/Group

Indicates whether this line applies to a Perforce user or group.

Name

A Helix Server user name or group name; can be wildcarded.

Host

The IP address of a client host; can be wildcarded.

Folder/File

The part of the depot to which access is being granted or denied. To deny access to
a depot path, preface the path with a dash (-). Exclusionary mappings apply to all
access levels, regardless of the access level specified in the first field.

Comment

Optional description of a table entry. Appends a comment at the end of a line using
the ## symbols. Forexample: write user * 10.1.1.1
//depot/test/... ## robinson crusoe

Configuring PAAdmin preferences

To configure settings for P4Admin, select Edit > Preferences (Windows) or P4Admin > Preferences
(Mac). The Preferences dialog includes the following configuration pages:

m "Connections" on the next page

= "Logging" on the next page

= "Display" on page 11

= "Files" on page 11

m "Behavior" on page 11

m "Tools" on page 12



Connections

= "Editor" on page 12
= "Diff" on page 13

Click Apply to save your changes. Click OK to save your changes and exit the dialog.

Connections

You can configure the following settings for connecting to a Helix Server:

When the application launches:

m Restore all previously opened connections: Do not prompt for connection settings; reconnect
to the server to which you were connected during your last session.

Opening and closing connections:

m Use IP-specific tickets when logging in: Specifies whether your login ticket is restricted to the
IP address from which you are connecting.

=m Automatically log off when closing a connection: Specifies whether your ticket is invalidated
when you log out.

Server Data

You can configure how much data P4Admin processes during a session to minimize server load for
frequently run commands and large data transfers. The following settings are available:

m Check server for updates every n minutes: Specifies how often P4Admin checks the Perforce
service for updated file information. Frequent checks enable P4AAdmin to display current file status
but increase the workload on the Perforce service.

m Maximum size of file to preview (excludes audio and video files): Limits the size of image
files displayed in the Preview tab on the Files pane, to limit the amount of image data sent from the
Perforce service to P4V.

Logging
You can configure the following logging options:

Log pane options:

= Show p4 reporting commands: Specifies whether the log pane in the Administration Tool
window displays all commands issued by the Administration Tool, including commands issued by
the Administration Tool to obtain status information from the Helix Server.

Logging to a file:

10



Display

m Enable logging to file: Logs Administration Tool activity to the specified file.
» Name: Specifies the name and location of the log file.

» Size: Specifies the maximum size of the log file.

Display
You can configure the following Administration Tool display and localization options:
Application:

m Dates: Sets the date format used throughout the Administration Tool.

« OS format: Use the format that your operating system uses.

« Perforce standard (yyyy/mm/dd hh:mm:ss): Use the application standard.
Localization:

= Language used for application menus, labels, and dialogs (requires restart): Select
language.

m Set encoding for all connections to: Sets the character encoding for connections to a unicode-
mode Helix Server.

If you do not set the encoding here, you are prompted to enter the character encoding every time
you set up a connection to a unicode-mode Helix Server. The encoding that you set here does not
affect server connections whose character encoding has already been set at connection. If you
are unsure which setting to choose, consult your Helix Server administrator.

Files
You can configure the way the Administration Tool displays files and file icons:

m Show Perforce filetype for files in the Depot tree: Toggles display of file type in the tree pane.

= Show revision information for files in the Depot tree: Toggles display of revision numbers in
the tree pane.

Application Font

You can configure the font family, style, and size for the application font and file content font that
P4Admin uses. For file content, you can also select to Show fixed sized fonts only. Selecting this
option limits the values available in the Font family list to fixed-sized fonts.

Behavior

You can configure the following Administration Tool user interface behaviors:

Drag and drop:

11



Tools

= on afile, do a diff comparisons: When selected, P4Admin launches the Diff dialog when you
drop a file on another file.

= anywhere within a changelist, move open files to new changelist: When selected, P4AAdmin
moves any open files to a new changelist when you drop a file within a changelist.

= on a file, do nothing: When selected, P4AAdmin does not do anything when you drop a file on
another file.

Tools

You can configure the following Revision Graph and Time-Lapse View options:

Revision Graph:

= Limit Revision Graph to ancestors and descendants: Limits afile’s integration history to
ancestors and descendants (default). This option has the smallest footprint and ensures optimized
performance.

m Show Full Revision history in Revision Graph: Displays the full integration history of the
branch. With this option, the revision graph might take longer to display.

Time-Lapse View:

m By default Time-lapse View should show: Specifies whether Time-lapse View displays the
integration/merge history for the selected file by default. You can also toggle the display of
integration history in Time-lapse View.

Editor

To associate file types with the applications you use to edit them:

1. Click Add.

2. Select afile extension from the drop-down list.
3. Enteror browse for the associated application.
4

(Optional) Select Always use the selected application to open files of this typeto set the
application as the default.

5. Click Save.

You can enter as many applications as you like for each extension. All of the applications will appear as
options when you right-click a file in the Administration Tool and select Open With.

Note

Any application that you’ve used to open a file from the context menu in the Administration Tool
appears by default as an associated application on the Editor page in the Administration Tool
Preferences dialog, unless you remove it.

12



Diff

Diff

To set the default diff application, select one of the following:

1.
2.

P4Merge: The companion diff tool.
Other application: Browse to your preferred diff tool.

To specify arguments for third-party diff applications, enter %1 for the name of the first file and %2
for the name of the second file in the Arguments field. Perforce replaces these placeholders with
the actual filenames when calling the diff application.

To assign diff applications by file type:

1

2
3.
4

Click Add.

Select a file extension from the drop-down list.

Enter or browse for the associated application.

Specify arguments for third-party diff applications in the Arguments field:

Enter %1 for the name of the first file and %2 for the name of the second file. The Administration
Tool replaces these placeholders with the actual filenames when calling the diff application.

Click Save.

The extension and associated application are displayed in the list of file type-application
associations.

Applets

You can enable a Helix Server to serve applets that can run in P4Admin. For these applets to run in
P4Admin, you must enable applets in the P4Admin preferences. For more information about Perforce
applets, see the Perforce Javascript API for Visual Tools User Guide.

To enable applets to run in P4Admin:

1.
2.

3.

Select Allow Perforce applets to run in P4Admin.

Specify the Helix Server (one or more) from which you are willing to accept Perforce applets:
» Enterthe Helix Server name or host : port in the Server field.
= Click Add.

Click Advanced to specify the following settings:

m Save cookies from applets (Click Remove Cookies to delete all applet-generated
cookies)

m Allow applets to store data locally

= Manually configure web proxy used by applets for internet access: Enter the web
proxy address and port.

13
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A

access level

A permission assigned to a user to control which commands the user can execute. See also the
'‘protections' entry in this glossary and the 'p4 protect' command in the P4 Command Reference.

admin access

An access level that gives the user permission to privileged commands, usually super privileges.

APC

The Alternative PHP Cache, a free, open, and robust framework for caching and optimizing PHP
intermediate code.

archive

1. For replication, versioned files (as opposed to database metadata). 2. For the 'p4 archive'
command, a special depotin which to copy the server data (ersioned files and metadata).

atomic change transaction

Grouping operations affecting a number of files in a single transaction. If all operations in the
transaction succeed, all the files are updated. If any operation in the transaction fails, none of the files
are updated.

avatar

A visual representation of a Swarm user or group. Avatars are used in Swarm to show involvementin
or ownership of projects, groups, changelists, reviews, comments, etc. See also the "Gravatar" entry
in this glossary.

base

The file revision, in conjunction with the source revision, used to help determine what integration
changes should be applied to the target revision.

14
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binary file type

A Helix Server file type assigned to a non-text file. By default, the contents of each revision are stored
in full, and file revision is stored in compressed format.

branch

(noun) A set of related files that exist at a specific location in the Perforce depot as a result of being
copied to that location, as opposed to being added to thatlocation. A group of related files is often
referred to as a codeline. (verb) To create a codeline by copying another codeline with the 'p4
integrate', 'p4 copy', or 'p4 populate' command.

branch form

The form that appears when you use the '‘p4 branch' command to create or modify a branch
specification.

branch mapping

Specifies how a branch is to be created or integrated by defining the location, the files, and the
exclusions of the original codeline and the target codeline. The branch mapping is used by the
integration process to create and update branches.

branch view

A specification of the branching relationship between two codelines in the depot. Each branch view
has a unique name and defines how files are mapped from the originating codeline to the target
codeline. This is the same as branch mapping.

broker

Helix Broker, a server process that intercepts commands to the Helix Server and is able to run scripts
on the commands before sending them to the Helix Server.

Cc

change review

The process of sending email to users who have registered their interest in changelists thatinclude
specified files in the depot.

changelist

A list of files, their version numbers, the changes made to the files, and a description of the changes
made. A changelist is the basic unit of versioned work in Helix Server. The changes specified in the
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changelist are not stored in the depot until the changelist is submitted to the depot. See also atomic
change transaction.

changelist form

The form that appears when you modify a changelist using the 'p4 change' command.

changelist number

The unique numeric identifier of a changelist. By default, changelists are sequential.

check in

To submit a file to the Helix Server depot.

check out

To designate one or more files for edit.

checkpoint

A backup copy of the underlying metadata at a particular moment in time. A checkpoint can recreate
db.user, db.protect, and other db.* files. See also metadata.

classic depot

A repository of Helix Server files that is not streams-based. The default depot name is depot. See
also default depot and stream depot.

client form

The form you use to define a client workspace, such as with the 'p4 client' or 'p4 workspace'
commands.

client name

A name that uniquely identifies the current client workspace. Client workspaces, labels, and branch
specifications cannot share the same name.

client root

The topmost (root) directory of a client workspace. If two or more client workspaces are located on
one machine, they should not share a client root directory.
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client side

The right-hand side of a mapping within a client view, specifying where the corresponding depot files
are located in the client workspace.

client workspace

Directories on your machine where you work on file revisions that are managed by Helix Server. By
default, this name is set to the name of the machine on which your client workspace is located, but it
can be overridden. Client workspaces, labels, and branch specifications cannot share the same
name.

code review

A process in Helix Swarm by which other developers can see your code, provide feedback, and
approve or reject your changes.

codeline

A set of files that evolve collectively. One codeline can be branched from another, allowing each set
of files to evolve separately.

comment

Feedback provided in Helix Swarm on a changelist, review, job, or a file within a changelist or
review.

commit server

A server thatis part of an edge/commit system that processes submitted files (checkins), global
workspaces, and promoted shelves.

conflict

1. A situation where two users open the same file for edit. One user submits the file, after which the
other user cannot submit unless the file is resolved. 2. A resolve where the same line is changed
when merging one file into another. This type of conflict occurs when the comparison of two files to a
base yields different results, indicating that the files have been changed in different ways. In this
case, the merge cannot be done automatically and must be resolved manually. See file conflict.

copy up

A Helix Server best practice to copy (and not merge) changes from less stable lines to more stable
lines. See also merge.
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counter

A numeric variable used to track variables such as changelists, checkpoints, and reviews.

CSRF

Cross-Site Request Forgery, a form of web-based attack that exploits the trust that a site hasin a
user's web browser.

D

default changelist

The changelist used by a file add, edit, or delete, unless a numbered changelist is specified. A
default pending changelist is created automatically when a file is opened for edit.

deleted file

In Helix Server, a file with its head revision marked as deleted. Older revisions of the file are still
available. in Helix Server, a deleted file is simply another revision of the file.

delta

The differences between two files.

depot

A file repository hosted on the server. A depotis the top-level unit of storage for versioned files (depot
files or source files) within a Helix Versioning Engine. It contains all versions of all files ever
submitted to the depot. There can be multiple depots on a single installation.

depot root

The topmost (root) directory for a depot.

depot side

The left side of any client view mapping, specifying the location of files in a depot.

depot syntax

Helix Server syntax for specifying the location of files in the depot. Depot syntax begins with: /depot/
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diff
(noun) A set of lines that do not match when two files are compared. A conflictis a pair of unequal

diffs between each of two files and a base. (verb) To compare the contents of files or file revisions.
See also conflict.

donor file

The file from which changes are taken when propagating changes from one file to another.

E

edge server

Areplica server that is part of an edge/commit system that is able to process most read/write
commands, including 'p4 integrate’, and also deliver versioned files (depot files).

exclusionary access

A permission that denies access to the specified files.

exclusionary mapping

A view mapping that excludes specific files or directories.

F

file conflict
In a three-way file merge, a situation in which two revisions of a file differ from each other and from
their base file. Also, an attempt to submit a file thatis not an edit of the head revision of the file in the
depot, which typically occurs when another user opens the file for edit after you have opened the file
for edit.

file pattern

Helix Server command line syntax that enables you to specify files using wildcards.

file repository

The master copy of all files, which is shared by all users. In Helix Server, this is called the depot.

19



Glossary

file revision

A specific version of a file within the depot. Each revision is assigned a number, in sequence. Any
revision can be accessed in the depot by its revision number, preceded by a pound sign (#), for
example testfile#3.

file tree

All the subdirectories and files under a given root directory.

file type

An attribute that determines how Helix Server stores and diffs a particular file. Examples of file types
are text and binary.

fix

A job that has been closed in a changelist.

form

A screen displayed by certain Helix Server commands. For example, you use the change form to
enter comments about a particular changelist to verify the affected files.

forwarding replica

A replica server that can process read-only commands and deliver versioned files (depot files). One
or more replicat servers can significantly improve performance by offloading some of the master
server load. In many cases, a forwarding replica can become a disaster recovery server.

G

Git Fusion

A Perforce product that integrates Git with Helix, offering enterprise-ready Git repository
management, and workflows that allow Git and Helix Server users to collaborate on the same
projects using their preferred tools.

graph depot
A depot of type graph thatis used to store Git repos in the Helix Server. See also Helix4Git.
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Gravatar

gravatar.com is a third party service that you can subscribe to, gravatar enables you to upload an
image that you can use in Swarm. When configured, Swarm will attempt to fetch your avatar from
gravatar.com and use it within Swarm. If your avatar is not found on gravatar.com, Swarm will use
one of its own default avatars to represent your activity. See also the "avatar" entry in this glossary.

group

A feature in Helix Server that makes it easier to manage permissions for multiple users.

H

have list

The list of file revisions currently in the client workspace.

head revision

The most recent revision of a file within the depot. Because file revisions are numbered sequentially,
this revision is the highest-numbered revision of that file.

Helix Server

The Helix Server depot and metadata; also, the program that manages the depot and metadata, also
called Helix Versioning Engine.

Helix TeamHub

A Perforce management platform for code and artifact repository. TeamHub offers built-in support for
Git, SVN, Mercurial, Maven, and more.

Helix4Git

Perforce solution for teams using Git. Helix4 Git offers both speed and scalability and supports hybrid
environments consisting of Git repositories and 'classic' Helix Server depots.

iconv

iconv is a PHP extension that performs character set conversion, and is an interface to the GNU
libiconv library.
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integrate

To compare two sets of files (for example, two codeline branches) and determine which changes in
one setapply to the other, determine if the changes have already been propagated, and propagate
any outstanding changes from one set to another.

job
A user-defined unit of work tracked by Helix Server. The job template determines what information is
tracked. The template can be modified by the Helix Server system administrator. A job describes

work to be done, such as a bug fix. Associating a job with a changelist records which changes fixed
the bug.

job daemon

A job daemon is a program that checks the Helix Server machine daily to determine if any jobs are
open. If so, the daemon sends an email message to interested users, informing them the number of
jobs in each category, the severity of each job, and more.

job specification

A form describing the fields and possible values for each job stored in the Helix Server machine.

job view

A syntax used for searching Helix Server jobs.

journal

A file containing a record of every change made to the Helix Server's metadata since the time of the
last checkpoint. This file grows as each Helix Server transaction is logged. The file should be
automatically truncated and renamed intoa numbered journal when a checkpointis taken.

journal rotation

The process of renaming the current journal to a numbered journal file.

journaling

The process of recording changes made to the Helix Server's metadata.
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L

label
A named list of user-specified file revisions.

label view
The view that specifies which filenames in the depot can be stored in a particular label.

lazy copy
A method used by Helix Server to make internal copies of files without duplicating file contentin the
depot. A lazy copy points to the original versioned file (depot file). Lazy copies minimize the
consumption of disk space by storing references to the original file instead of copies of the file.

license file
A file that ensures that the number of Helix Server users on your site does not exceed the number for
which you have paid.

list access
A protection level that enables you to run reporting commands but prevents access to the contents of
files.

local depot
Any depot located on the currently specified Helix Server.

local syntax
The syntax for specifying a filename that is specific to an operating system.

lock
1. Afile lock that prevents other clients from submitting the locked file. Files are unlocked with the 'p4
unlock' command or by submitting the changelist that contains the locked file. 2. A database lock that
prevents another process from modifying the database db.* file.

log

Error output from the Helix Server. To specify a log file, set the P4ALOG environment variable or use
the p4d -L flag when starting the service.
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mapping

A single line in a view, consisting of a left side and a right side that specify the correspondences
between files in the depot and files in a client, label, or branch. See also workspace view, branch
view, and label view.

MDS checksum

The method used by Helix Server to verify the integrity of versioned files (depot files).

merge

1. To create new files from existing files, preserving their ancestry (branching). 2. To propagate
changes from one set of files to another. 3. The process of combining the contents of two conflicting
file revisions into a single file, typically using a merge tool like P4Merge.

merge file

A file generated by the Helix Server from two conflicting file revisions.

metadata

The data stored by the Helix Server that describes the files in the depot, the current state of client
workspaces, protections, users, labels, and branches. Metadata includes all the data stored in the
Perforce service except for the actual contents of the files.

modification time or modtime

The time a file was last changed.

MPM

Multi-Processing Module, a component of the Apache web server that is responsible for binding to
network ports, accepting requests, and dispatch operations to handle the request.

N

nonexistent revision

A completely empty revision of any file. Syncing to a nonexistent revision of a file removes it from
your workspace. An empty file revision created by deleting a file and the #none revision specifier are
examples of nonexistent file revisions.
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numbered changelist

A pending changelist to which Helix Server has assigned a number.

(0)

opened file
Afile that you are changing in your client workspace that is checked out. If the file is not checked out,
opening itin the file system does not mean anything to the versioning engineer.

owner
The Helix Server user who created a particular client, branch, or label.

P

p4
1. The Helix Versioning Engine command line program. 2. The command you issue to execute
commands from the operating system command line.

p4d
The program that runs the Helix Server; p4d manages depot files and metadata.

P4PHP
The PHP interface to the Helix API, which enables you to write PHP code that interacts with a Helix
Server machine.

PECL

PHP Extension Community Library, a library of extensions that can be added to PHP to improve and
extend its functionality.

pending changelist

A changelist that has not been submitted.
project

In Helix Swarm, a group of Helix Server users who are working together on a specific codebase,
defined by one or more branches of code, along with options for a job filter, automated test
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integration, and automated deployment.

protections

The permissions stored in the Helix Server’s protections table.

proxy server

A Helix Server that stores versioned files. A proxy server does not perform any commands. It serves
versioned files to Helix Server clients.

R

RCS format

Revision Control System format. Used for storing revisions of text files in versioned files (depot files).
RCS format uses reverse delta encoding for file storage. Helix Server uses RCS format to store text
files. See also reverse delta storage.

read access

A protection level that enables you to read the contents of files managed by Helix Server but not
make any changes.

remote depot

A depotlocated on another Helix Server accessed by the current Helix Server.

replica

A Helix Server that contains a full or partial copy of metadata from a master Helix Server. Replica
servers are typically updated every second to stay synchronized with the master server.

repo

A graph depot contains one or more repos, and each repo contains files from Git users.

reresolve

The process of resolving a file after the file is resolved and before itis submitted.
resolve

The process you use to manage the differences between two revisions of a file. You can choose to
resolve conflicts by selecting the source or target file to be submitted, by merging the contents of
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conflicting files, or by making additional changes.

reverse delta storage

The method that Helix Server uses to store revisions of text files. Helix Server stores the changes
between each revision and its previous revision, plus the full text of the head revision.

revert

To discard the changes you have made to a file in the client workspace before a submit.

review access

A special protections level that includes read and list accesses and grants permission to run the p4
review command.

review daemon

A review daemon is a program that periodically checks the Helix Server machine to determine if any
changelists have been submitted. If so, the daemon sends an email message to users who have
subscribed to any of the files included in those changelists, informing them of changes in files they
are interested in.

revision number

A number indicating which revision of the file is being referred to, typically designated with a pound
sign (#).

revision range

A range of revision numbers for a specified file, specified as the low and high end of the range. For
example, myfile#5,7 specifies revisions 5 through 7 of myfile.

revision specification

A suffix to a filename that specifies a particular revision of that file. Revision specifiers can be
revision numbers, a revision range, change numbers, label names, date/time specifications, or client
names.

RPM

RPM Package Manager is a tool, and package format, for managing the installation, updates, and
removal of software packages for Linux distributions such as Red Hat Enterprise Linux, the Fedora
Project, and the CentOS Project.
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S

server data
The combination of server metadata (the Helix Server database) and the depot files (your
organization's versioned source code and binary assets).

server root
The topmost directory in which p4d stores its metadata (db.* files) and all versioned files (depot files
or source files). To specify the server root, set the PAROOT environment variable or use the p4d -r
flag.

service
In the Helix Versioning Engine, the shared versioning service that responds to requests from Helix
Server client applications. The Helix Server (p4d) maintains depot files and metadata describing the
files and also tracks the state of client workspaces.

shelve
The process of temporarily storing files in the Helix Server without checking in a changelist.

status
For a changelist, a value that indicates whether the changelistis new, pending, or submitted. For a
job, a value that indicates whether the job is open, closed, or suspended. You can customize job
statuses. For the 'p4 status' command, by default the files opened and the files that need to be
reconciled.

stream

A branch with additional intelligence that determines what changes should be propagated and in
what order they should be propagated.

stream depot

A depot used with streams and stream clients.

submit

To send a pending changelist into the Helix Server depot for processing.
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super access

An access level that gives the user permission to run every Helix Server command, including
commands that set protections, install triggers, or shut down the service for maintenance.

symlink file type

A Helix Server file type assigned to symbolic links. On platforms that do not support symbolic links,
symlink files appear as small text files.

sync

To copy a file revision (or set of file revisions) from the Helix Server depot to a client workspace.

T

target file

The file that receives the changes from the donor file when you integrate changes between two
codelines.

text file type

Helix Server file type assigned to a file that contains only ASCII text, including Unicode text. See also
binary file type.

theirs

The revision in the depot with which the client file (your file) is merged when you resolve a file
conflict. When you are working with branched files, theirs is the donor file.

three-way merge

The process of combining three file revisions. During a three-way merge, you can identify where
conflicting changes have occurred and specify how you want to resolve the conflicts.

trigger

A script automatically invoked by Helix Server when various conditions are met. (See "Helix
Versioning Engine Administrator Guide: Fundamentals" on "Using triggers to customize behavior")

two-way merge

The process of combining two file revisions. In a two-way merge, you can see differences between
the files.
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typemap

A table in Helix Server in which you assign file types to files.

U

user

The identifier that Helix Server uses to determine who is performing an operation.

\

versioned file

Source files stored in the Helix Server depot, including one or more revisions. Also known as a depot
file or source file. Versioned files typically use the naming convention 'filenamev' or '1.changelist.gz'.

view

A description of the relationship between two sets of files. See workspace view, label view, branch

view.

w

wildcard
A special character used to match other characters in strings. The following wildcards are available
in Helix Server: * matches anything except a slash; ... matches anything including slashes; % %0
through %%9 is used for parameter substitution in views.

workspace

See client workspace.

workspace view

A set of mappings that specifies the correspondence between file locations in the depot and the
client workspace.

write access

A protection level that enables you to run commands that alter the contents of files in the depot. Write
access includes read and list accesses.
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X

XSS

Cross-Site Scripting, a form of web-based attack that injects malicious code into a user's web
browser.

Y

yours

The edited version of a file in your client workspace when you resolve a file. Also, the target file when
you integrate a branched file.
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License statements

Perforce Software includes software developed by the University of California, Berkeley and its
contributors. This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit (http://www.openssl.org/).

Perforce Software includes software from the Apache ZooKeeper project, developed by the Apache
Software Foundation and its contributors. (http://zookeeper.apache.org/)

Perforce Software includes software developed by the OpenLDAP Foundation
(http://www.openldap.org/).
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